Please note that Cypress is an Infineon Technologies Company.
The document following this cover page is marked as “Cypress” document as this is the company that originally developed the product. Please note that Infineon will continue to offer the product to new and existing customers as part of the Infineon product portfolio.

Continuity of document content
The fact that Infineon offers the following product as part of the Infineon product portfolio does not lead to any changes to this document. Future revisions will occur when appropriate, and any changes will be set out on the document history page.

Continuity of ordering part numbers
Infineon continues to support existing part numbers. Please continue to use the ordering part numbers listed in the datasheet for ordering.
© Cypress Semiconductor Corporation, 2017-2020. This document is the property of Cypress Semiconductor Corporation and its subsidiaries (“Cypress”). This document, including any software or firmware included or referenced in this document (“Software”), is owned by Cypress under the intellectual property laws and treaties of the United States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resellers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents that are infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware products. Any other use, reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. No computing device can be absolutely secure. Therefore, despite security measures implemented in Cypress hardware or software products, Cypress shall have no liability arising out of any security breach, such as unauthorized access to or use of a Cypress product. CYPRESS DOES NOT REPRESENT, WARRANT, OR GUARANTEE THAT CYPRESS PRODUCTS, OR SYSTEMS CREATED USING CYPRESS PRODUCTS, WILL BE FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (collectively, “Security Breach”). Cypress disclaims any liability relating to any Security Breach, and you shall and hereby do release Cypress from any claim, damage, or other liability arising from any Security Breach. In addition, the products described in these materials may contain design defects or errors known as errata which may cause the product to deviate from published specifications. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in this document. Any information provided in this document, including any sample design information or programming code, is provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality and safety of any application made of this information and any resulting product. “High-Risk Device” means any device or system whose failure could cause personal injury, death, or property damage. Examples of High-Risk Devices are weapons, nuclear installations, surgical implants, and other medical devices. “Critical Component” means any component of a High-Risk Device whose failure to perform can be reasonably expected to cause, directly or indirectly, the failure of the High-Risk Device, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do release Cypress from any claim, damage, or other liability arising from any use of a Cypress product as a Critical Component in a High-Risk Device. You shall indemnify and hold Cypress, its directors, officers, employees, agents, affiliates, distributors, and assigns harmless from and against all claims, costs, damages, and expenses, arising out of any claim, including claims for product liability, personal injury or death, or property damage arising from any use of a Cypress product as a Critical Component in a High-Risk Device. Cypress products are not intended or authorized for use as a Critical Component in any High-Risk Device except to the limited extent that (i) Cypress’s published data sheet for the product explicitly states Cypress has qualified the product for use in a specific High-Risk Device, or (ii) Cypress has given you advance written authorization to use the product as a Critical Component in the specific High-Risk Device and you have signed a separate indemnification agreement.

Cypress, the Cypress logo, Spanision, the Spanision logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respective owners.

IMPORTANT NOTE REGARDING PROTECTED FIRMWARE DOWNLOAD: Cypress has implemented protections in the product to prevent unauthorized firmware updates from being applied to the product. However, no computing device or system can be absolutely secure. Therefore, the parties agree that Cypress shall not have any liability arising out of any failure of the product’s security features, such as the inability to load firmware or a breach allowing the loading of unauthorized firmware.
Contents

1. Introduction.........................................................................................................................5
   1.1 Contents ......................................................................................................................5
   1.2 System Requirements .................................................................................................6
       1.2.1 Hardware Requirements ....................................................................................6
       1.2.2 Software Requirements ....................................................................................6
   1.3 EZ-PD CCG4 USB Type-C Dock Reference Design ....................................................7
   1.4 Additional Resources...................................................................................................8
   1.5 Technical Support .......................................................................................................8
   1.6 Document Conventions .............................................................................................9
   1.7 Abbreviations ...........................................................................................................9

2. Installation..........................................................................................................................10
   2.1 EZ-PD CCGx Dock SDK Software Installation ...........................................................10

3. CCG4 Dock Hardware Revision 04 and Revision 05 .......................................................12
   3.1 Introduction ................................................................................................................12
   3.2 EZ-PD CCG4 USB Type-C Dock Hardware Revision 04 ............................................12
   3.3 EZ-PD CCG4 USB Type-C Dock Hardware Revision 05 ............................................12

4. Firmware Update ............................................................................................................13
   4.1 Introduction ................................................................................................................13
   4.2 Dock Management Controller (DMC) ........................................................................13
       4.2.1 Signed Firmware Update ..................................................................................14
   4.3 EZ-PD Dock DMC Configuration Generation Tool ....................................................14
   4.4 EZ-PD Dock Image Creation Tool .............................................................................19
       4.4.1 Single Composite (Combined) Dock Image .......................................................19
   4.5 EZ-PD Dock Firmware Update Tool .........................................................................20
   4.6 Firmware Update Tools Overview .............................................................................20
       4.6.1 Updating DMC Configuration ...........................................................................21
       4.6.2 Dock Image Creation .........................................................................................24
       4.6.3 Dock Firmware Update ......................................................................................27
       4.6.4 USB Serial Number Update Tool .....................................................................32
   4.7 Quick Start on EZ-PD CCG4 USB Type-C Dock Firmware Update .........................32
       4.7.1 Query Dock Status ............................................................................................32
       4.7.2 Configure DMC Images ....................................................................................34
       4.7.3 Create Dock Composite Image ..........................................................................35
       4.7.4 Dock Firmware Update ......................................................................................36
   4.8 Firmware Update Logic .............................................................................................38
       4.8.1 Firmware Version Check Disabled .....................................................................38
       4.8.2 Firmware Version Check Enabled .....................................................................38
Contents

4.8.3 Update Logic and Versioning Scheme..........................................................................................40
4.9 Extending the EZ-PD Dock Design..................................................................................................41
  4.9.1 Defining the New Dock Design..................................................................................................41
  4.9.2 Configuring DMC for New Designs............................................................................................43
  4.9.3 Configuring CCG4 for New Designs.............................................................................................43
  4.9.4 Configuring HX3 for New Designs.............................................................................................44
  4.9.5 Create Composite Dock Image for New Designs .........................................................................44

5. Dock Design Checklist.......................................................................................................................45
  5.1 Checklist........................................................................................................................................45

6. Troubleshooting Guide......................................................................................................................46
  6.1 Troubleshooting EZ-PD Dock Configuration Generation Tool..........................................................46
  6.2 Troubleshooting EZ-PD Dock Image Creation Tool.........................................................................46
  6.3 Troubleshooting EZ-PD Dock Firmware Update Tool......................................................................47

Revision History...................................................................................................................................50
1. Introduction

Thank you for your interest in the EZ-PD™ CCG4 USB Type-C Dock Reference Design. This reference design is an easy-to-use dock solution that supports Upstream Type-C port supporting DisplayPort sink, power source, and USB device over a USB SuperSpeed hub and Downstream Type-C port supporting DisplayPort source, power source, and USB hub downstream port.

The EZ-PD CCG4 USB Type-C Dock based design enables you to evaluate the Cypress Type-C Dock solution. This user guide documents the software tools required to update the firmware of various components in the dock and explains the use of each.

This version of Dock SDK supports CCG4 Dock and HX3PD Hub. This document will focus only on CCG4 Dock.

Note: EZ-PD CCG4 USB Type-C Dock is an upgraded version of EZ-PD Dock Reference Design version 1.1. For details please check EZ-PD Dock Reference Design version 1.1 from the Cypress website.

1.1 Contents

The EZ-PD CCGx Dock SDK package consists of the following folders and sub-folders. This version of Dock SDK supports EZ-PD CCG4 USB Type-C Dock and EZ-USB HX3PD Hub.

Figure 1-1. Dock SDK Contents

- EZ-PD CCGx Dock SDK
  - Documentation
    - CCG4_Dock
    - HX3PD_Hub
  - Firmware
    - binaries
    - lib
    - projects
    - src
  - Hardware
    - CCG4_Dock
    - HX3PD_Hub
  - License
  - Software Tools
  - Updater

• **Firmware**: Contains the firmware binaries for various dock components, firmware stack sources, pre-compiled libraries, and a reference project for the EZ-PD CCG4 USB Type-C Dock.

• **Hardware**: CCG4_Dock folder under Hardware includes reference schematic, BOM list, and layout files.

• **License**: Includes the Cypress Software and End User License Agreements.

• **Software Tools**: Includes the software tools to do firmware update of the dock components and also:
  - CCG4 Configuration: EZ-PD Configuration Utility (Installer) with support for the CCGx part to configure the Cypress PD Controller
  - HX3 Configuration: HX3 Blaster Plus Utility (Installer)
  - Dock Serial Number Update tool: This tool (DockSerialNumberUpdateTool.exe) is used to update the custom serial number for HX3 and DMC

### 1.2 System Requirements

#### 1.2.1 Hardware Requirements

- Windows-based PC
- USB Type-A to Type-C Cable

  **Note**: If the PC supports a Type-C port, USB Type-C to Type-C cable is required instead of USB Type-A to Type-C cable.

- EZ-PD CCG4 USB Type-C Dock Hardware

#### 1.2.2 Software Requirements

The following is the list of recommended Windows versions to run the Software Tools part of the CCC4 Dock Reference Design Package.

- Windows 7 (32-bit and 64-bit)
- Windows 8.1 (32-bit and 64-bit)
- Windows 10 (32-bit and 64-bit)
1.3 EZ-PD CCG4 USB Type-C Dock Reference Design

The EZ-PD CCG4 USB Type-C Dock Design is a self-powered dock capable of providing power to both upstream and downstream ports while providing display and USB functionality. The EZ-PD CCG4 USB Type-C Dock Reference Design contains the following:

- Upstream Type-C port capable of providing power up to 60 W at 20 V (extendable to 100 W at 20 V with minor hardware and firmware configuration changes), USB 3.1 Gen 1 (5 Gbps) data sink, and DisplayPort sink capability to HDMI
- Downstream Type-C port capable of providing power up to 15 W at 5 V, USB 3.1 Gen 1 (5 Gbps) data source and provides DisplayPort source capability
- HDMI port for Display output
- Three USB 3.0 legacy Type-A connectors
- Two USB Hi-Speed downstream ports (legacy Type-A connector)
- RJ45 port to provide Ethernet connectivity
The EZ-PD CCG4 USB Type-C Dock Reference Design has the following Cypress components:

- CYPD4236-40LQXI as a dual-port PD Controller (CCG4)
  - Manages both Type-C ports
- CY7C65219-40LQXI as a Dock Management Controller (DMC)
  - Provides USB Billboard class support and firmware download support
- Two CYUSB3314 devices as USB SuperSpeed hubs
  - Expand USB SuperSpeed ports
- CY7C65632 as USB Hi-Speed hub
  - Expands USB Hi-Speed ports
- CYUSB3610 as USB Ethernet Controller
  - Provides USB to Ethernet functionality

Refer to Figure 1-2 for the block diagram of the EZ-PD CCG4 USB Type-C Dock Reference Design:

Key application-level requirements for the CCG4 Dock Reference Design are:

- PD3.0-capable Upstream Type-C port supporting sourcing power, DisplayPort sink, and USB device
- PD3.0-capable Downstream Type-C port supporting sourcing power, DisplayPort source, and USB downstream port
- Downstream SuperSpeed and Hi-Speed ports for port expansion
- USB-to-Ethernet functionality to provide Ethernet connectivity
- Billboard v1.21 specification support
- Firmware download support

Attribution Notice
The Signed Firmware update feature is available for this reference design. Contact Cypress for more details.

1.4 Additional Resources

Visit the EZ-PD Dock reference design web page for additional learning resources such as datasheets, application notes, and knowledge base article since EZ-PD CCG4 USB Type-C Dock is an upgraded version of EZ-PD™ Dock Reference Design version 1.1.

1.5 Technical Support

For assistance, go to our support web page or contact customer support at +1 (800) 541-4736 Ext. 8 (in the USA), or +1 (408) 943-2600 Ext. 8 (International).
1.6 Document Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier New</td>
<td>Displays user-entered text and source code:</td>
</tr>
<tr>
<td></td>
<td>&gt;ezpd_dockcreateimage.exe -i</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>Displays file names and reference documentation:</td>
</tr>
<tr>
<td></td>
<td>For example, CY4701.cyuab</td>
</tr>
<tr>
<td>[Bracketed, Bold]</td>
<td>Displays keyboard commands in procedures:</td>
</tr>
<tr>
<td></td>
<td>Enter or Ctrl + C</td>
</tr>
<tr>
<td>File &gt; Open</td>
<td>Represents menu paths:</td>
</tr>
<tr>
<td></td>
<td>File &gt; Open &gt; New Project</td>
</tr>
<tr>
<td>Bold</td>
<td>Displays commands, menu paths, and icon names in procedures:</td>
</tr>
<tr>
<td></td>
<td>Click the File icon and then click Open.</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>Displays an equation:</td>
</tr>
<tr>
<td></td>
<td>2 + 2 = 4</td>
</tr>
<tr>
<td>Text in gray boxes</td>
<td>Describes cautions or unique functionality of the product</td>
</tr>
</tbody>
</table>

1.7 Abbreviations

The following table lists the abbreviations used in this design guide.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDTT</td>
<td>Composite Dock Topology Table</td>
</tr>
<tr>
<td>CCG3</td>
<td>Cypress USB Type-C Controller with Power Delivery targeting power adapters,</td>
</tr>
<tr>
<td></td>
<td>power banks, Type-C Dongles, Thunderbolt accessories, monitors, docks,</td>
</tr>
<tr>
<td></td>
<td>and notebooks.</td>
</tr>
<tr>
<td>CCG4</td>
<td>Cypress 2-Port Type-C Controller with Power Delivery targeting Desktops,</td>
</tr>
<tr>
<td></td>
<td>notebooks and systems like power banks, monitors, and docks.</td>
</tr>
<tr>
<td>CCG5</td>
<td>EZ-PD™ CCG5 is Cypress’ 2-port USB Type-C and Power Delivery controller</td>
</tr>
<tr>
<td></td>
<td>targeting desktops, notebooks and docking stations.</td>
</tr>
<tr>
<td>DMC</td>
<td>Dock Management Controller</td>
</tr>
<tr>
<td>FW</td>
<td>Firmware</td>
</tr>
<tr>
<td>FWCT</td>
<td>Firmware Config Table</td>
</tr>
<tr>
<td>HPI</td>
<td>Host Processor Interface (protocol used to communicate between DMC and</td>
</tr>
<tr>
<td></td>
<td>CCG4)</td>
</tr>
<tr>
<td>HX3</td>
<td>Cypress USB 3.0 HUB Controller</td>
</tr>
<tr>
<td>PID</td>
<td>Product ID</td>
</tr>
<tr>
<td>SHA</td>
<td>Secure Hash Algorithm</td>
</tr>
<tr>
<td>SHA-256</td>
<td>SHA-256 is a novel hash function, part of SHA2 family</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VID</td>
<td>Vendor ID</td>
</tr>
</tbody>
</table>
This chapter describes the procedure to install the EZ-PD CCGx Dock SDK to get the Reference Designs software.

2.1 EZ-PD CCGx Dock SDK Software Installation

To install the software, follow these steps:

1. Download the latest Cypress EZ-PD CCGx Dock SDK software setup file EZPDCCGXDOCKSDKSetup.exe, from the EZ-PD CCGx Dock SDK Dock web page. This package contains the firmware binaries, sources, tools, hardware files, and the kit documentation. Double-click on the executable file to start the installation. Click Next when the following screen shown appears.

![Figure 2-1. EZ-PD CCGx Dock SDK Installer Screen](image-url)
2. Select the required Installation Type and click Next to start the installation. For first-time installation, it is recommended that you select Typical as the Installation Type.

3. Accept the Cypress End User License Agreement and click Next.

4. Click Finish to complete the installation.

5. When installation is complete, you have the option to Launch Cypress Update Manager to ensure you have the latest software package. Click the Check for updates button at the bottom of the window. If No Updates appears, click the Exit button. If there are updates, click the Update button to download and install the latest kit package.

Figure 2-2. Cypress Update Manager

6. After the installation is complete, the contents are available at the following location: 

   <Install Directory>/EZ-PD CCGx Dock SDK

Note: You can launch the Cypress Update Manager at any time from Start > All Programs > Cypress > Cypress Update Manager.

Note: On the Windows 32-bit platform, the default <Install Directory> is C:\Program Files\Cypress; on the Windows 64-bit platform, it is C:\Program Files(x86)\Cypress.
3. CCG4 Dock Hardware Revision 04 and Revision 05

3.1 Introduction

This chapter explains the details of EZ-PD CCG4 USB Type-C Dock’s Revision 04 and Revision 05 hardware.

Note: The EZ-PD CCG4 USB Type-C Dock application included in this SDK is an upgrade to the application previously released as part of the EZ-PD Dock Reference Design version 1.1.

3.2 EZ-PD CCG4 USB Type-C Dock Hardware Revision 04

EZ-PD CCG4 USB Type-C Dock Revision 04 refers to the existing Cypress EZ-PD Dock Reference Design version 1.1 design. For details, see EZ-PD Dock Reference Design version 1.1 from the Cypress web page. However, the documentation and the hardware folders of Dock SDK package have the details of Revision 04 hardware.

3.3 EZ-PD CCG4 USB Type-C Dock Hardware Revision 05

EZ-PD CCG4 USB Type-C Dock Revision 05 hardware is the next upgraded version of Cypress EZ-PD Dock Reference Design version 1.1 with the following additional features compared to Revision 04.

- Power Adapter Detect: Ability to detect the validity of the power adaptor connected and take appropriate action based on the design.
- Added Over Current Protection (OCP) using Buck Boost controller.
- Added Power Saving feature for OCP Buck Boost controller.
- Support for EuP/ErP power feature: To achieve EuP/ErP power feature, the dock design should be able to identify the US Connect and disconnect states. In this reference design, the CCG4_VBUS_P_CTRL_US pin is used for this purpose. Currently, in this reference design, the Buck Boost controller is put into low-power state when the upstream is not connected (and vice-versa), based on the upstream connect and disconnect notification. This can be further enhanced to put other components in the dock design into low power as per the design, when the upstream is in detached state to achieve the EuP/ErP power feature.
- Ability to dynamically switch DisplayPort (DP) Lane using Button Control: Button Press on the US detached state will switch the DP Lane to “2 Lane” DP if already in “4 Lane” Display Port and vice versa.

These features are specific to Revision 05 CCG4 Dock Hardware because this requires hardware support. See the Hardware files from the Dock SDK package to understand the hardware changes of EZ-PD CCG4 USB Type-C Dock Revision 05.
4. Firmware Update

4.1 Introduction

This chapter introduces the dock management controller and various software tools used to update the firmware of various components of the dock and explains the steps.

4.2 Dock Management Controller (DMC)

The Dock Management Controller (DMC) is specifically designed for dock and monitor solutions that include a USB Billboard Controller. DMC provides USB Full Speed capability to support the latest USB Billboard device class and firmware download interface (USB vendor interface) over USB. The DMC is expected to provide access to all programmable (that is, firmware- or configuration-capable) devices for firmware update.

Figure 4-1 shows the internal blocks interfaced with the DMC and the dock firmware update using the EZ-PD Dock Firmware Update Tool, a command-line tool, running on the host PC. Firmware update is initiated by the EZ-PD Dock Firmware Update Tool talking to the DMC within the EZ-PD CCG4 USB Type-C dock, over the USB interface. DMC supports a vendor USB interface that binds to the WinUSB driver.

Firmware update is initiated by the EZ-PD Dock Firmware Update Tool using vendor commands. The logic followed for firmware update is explained below.

1. Individual firmware images of dock components are pre-processed by another tool, referred to as the EZ-PD Dock Image Creation Tool (see Section 0).
   - The EZ-PD Dock Image Creation Tool is used to create a single combined firmware image file, referred to as the composite dock image (.bin) from multiple firmware images of different components present in the dock. The EZ-PD Dock Image Creation Tool also extracts the necessary metadata out of individual images and adds it to the composite dock image. This metadata information is referred as the Firmware Config Table (FWCT).
   - The EZ-PD Dock Image Creation Tool takes another XML file as input, referred to as the Dock Config XML, which contains the dock topology information. The dock topology information is static information related to the dock, such
as dock identification, number of devices connected to DMC, DMC interface (I²C/ SPI/UART) over which DMC can update the device firmware, DMC port number connected to the respective device, and so on. This dock topology-related information is referred as the Composite Dock Topology table (CDTT).

- This dock topology information is also stored in the DMC flash, in the configuration space for use by the DMC firmware logic.

2. The composite dock image (containing the FWCT information) created by the EZ-PD Dock Image Creation Tool is used by the EZ-PD Dock Firmware Update Tool.

- The FWCT contains all relevant information needed by the EZ-PD Dock Firmware Update Tool to update the firmware of various dock components.

3. The EZ-PD Dock Firmware Update Tool, upon receiving the composite dock image, sends the FWCT information to the DMC over the USB vendor interface.

4. Once the DMC receives the FWCT, it validates the FWCT against the CDTT information stored within the DMC.

- The DMC configuration space also needs the dock topology information (CDTT) – the same as that was used by the EZ-PD Dock Image Creation Tool to create the composite dock image.

- Another tool referred to as the EZ-PD Dock DMC Configuration Generation Tool (see Section 4.3) is used to modify the DMC configuration space.

- The default (factory) DMC firmware contains an empty CDTT, which implies that it does not have the information about the dock topology (such as dock identification, number of devices connected to the DMC, the DMC interface (I²C/ SPI/UART) over which the DMC can update the device firmware, and the DMC port number connected to the respective device). Therefore, the DMC can update only its own firmware. Once the DMC has a valid CDTT in its configuration space, it can update the firmware of other dock components connected to it (over the respective interface connecting the DMC and the device).

Note: DMC with empty CDTT can enumerate only if all the hubs, under which the DMC is connected, have a valid running firmware.

5. After the FWCT is validated, implying that it is identified as a valid set of firmware images for the intended dock, DMC analyzes the FWCT to identify the set of devices that need update.

6. Once identified, the DMC and the EZ-PD Dock Firmware Update Tool communicate with each other over the WinUsb Vendor Interface to update the firmware of various dock components.

- Firmware image row data for any particular device from the EZ-PD Dock Firmware Update Tool is sent over a BULK endpoint. The device request and status are sent over the Interrupt IN endpoint.

- While updating the firmware, the DMC calculates the SHA-256 hash for each firmware image. If the calculated hash for a specific firmware image does not match with the hash received as part of the FWCT, that firmware image is marked as invalid.

7. Extensive dock status information is also displayed by the EZ-PD Dock Firmware Update Tool including the overall firmware update status (Complete/ Fail) along with the status and firmware versions of the individual dock components.

### 4.2.1 Signed Firmware Update

Signed firmware update support, which is not covered in this guide, is available for DMC. Contact Cypress for support on signed firmware update.

### 4.3 EZ-PD Dock DMC Configuration Generation Tool

The EZ-PD Dock DMC Configuration Generation Tool can be used to recreate DMC images (.cyacd files) and configuration table file (.config.c) with the modified configuration. User can replace the existing config.c file in the DMC project with the modified config.c and build the new modified DMC application using PSoC Creator. The tool takes the DMC firmware image in .cyacd format along with configuration space parameters in XML format. The template input XML file (Dock Config XML) accepted by the tool is part of the package and can be found at the following location:

<Install Dir>\EZ-PD CCGx Dock SDK\Software Tools\CCG4_Dock\CY7C65219-40LQXI_dock_config.xml

Note: The same XML file format (Dock Config XML) is used for the EZ-PD Dock DMC Configuration Generation Tool and EZ-PD Dock Image Creation Tool for ease of use. Relevant parameters needed by the respective tool will be read and used.
Update the Dock Config XML file to suit the dock design once and reuse it across the various tools. Follow the comments in the Dock Config XML file to update the file.

The DMC configuration contains application-specific configuration parameters of the DMC that are stored in the configuration space within the DMC flash. This configuration includes the following:

- Composite dock topology table (CDTT) information: This is the static information related to the dock, such as the dock identification, number of devices connected to DMC, DMC interface (I²C/ SPI/ UART) over which DMC can update the device firmware, and the DMC port number connected to the respective device. The structure of the CDTT that goes into the configuration space of the DMC is shown in Table 4-1, Table 4-2, and Table 4-3.

Notes:
1 The Default Value column shows the value that comes by default in the DMC factory firmware (with an empty CDTT).
2 The Valid CDTT column shows the value corresponding to the CCG4 Dock reference design.
3 Any change in CDTT will result in three rounds of DMC firmware update.

- Billboard configuration parameters (described in Table 4-4): 1 KB is reserved for the billboard-specific configuration in the DMC flash.

Note: Table 4-4 does not show the memory layout of the Billboard configuration parameters as in the DMC flash.

The DMC configuration table is part of the firmware image and is updated as part of the DMC firmware update. The EZ-PD Dock DMC Configuration Generation Tool extracts the DMC configuration space parameters from the Dock Config XML file and creates DMC images with the modified configuration space parameters.

Table 4-1. Composite Dock Topology Table (CDTT) Structure

<table>
<thead>
<tr>
<th>Field</th>
<th>Size (Bytes)</th>
<th>Description</th>
<th>Default Value (Empty CDTT)</th>
<th>Valid CDTT (EZ-PD Dock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>1</td>
<td>0 = Empty CDTT. If this field is 0, then other fields within CDTT are invalid (Values as in column “Default Value”). 1 = Valid CDTT: CDTT structure version 1 used. 2 = Valid CDTT: CDTT structure version 2 (the latest version). 3-0xFF = Reserved for future use.</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>CDTT_VER</td>
<td>1</td>
<td>Version number for the dock topology. (Customer determined value) Any change in the dock topology must be accompanied with an incremental cdtt_version. Any reordering of existing devices or new addition of device (dev_info) is treated as a change in the dock topology.</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>2</td>
<td>2-byte ID to identify the customer/vendor corresponding to the dock. This is used only for dock identification and cannot be changed dynamically. It is not the same as the DMC VID (in Table 4-4) with which it enumerates.</td>
<td>0</td>
<td>0x04B4</td>
</tr>
<tr>
<td>Product ID</td>
<td>2</td>
<td>2-byte ID to identify the product corresponding to the dock. This is used only for dock identification and cannot be changed dynamically. It is not the same as the DMC PID (in Table 4-4) with which it enumerates.</td>
<td>0</td>
<td>0x5220</td>
</tr>
<tr>
<td>Device ID</td>
<td>2</td>
<td>Dock Device ID. This is used only for dock identification and cannot be changed dynamically.</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Caution: 0x04B4 is the Cypress USB Vendor ID (VID) and is used on the EZ-PD CCG4 USB Type-C Dock reference design for demonstration purposes only. Production dock releases, based on this design, are required to use VID of the manufacturer/OEM instead of the Cypress VID. USB VIDs are assigned and maintained by USB Implementers Forum, Inc. (USB-IF). The USB-IF recommends that each manufacturer/OEM set up a coordinated allocation scheme for Product IDs (PIDs) so that different teams do not inadvertently choose the same PID for different products of the same manufacturer/ OEM. For more information on USB-IF membership and on how to obtain a VID, visit [http://www.usb.org](http://www.usb.org). Contact Cypress customer support for any further clarifications.
<table>
<thead>
<tr>
<th>Field</th>
<th>Size (Bytes)</th>
<th>Description</th>
<th>Default Value (Empty CDTT)</th>
<th>Valid CDTT (EZ-PD Dock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>32</td>
<td>Null terminated string that identifies the vendor corresponding to the dock.</td>
<td>NULL string</td>
<td>Cypress Semiconductor</td>
</tr>
<tr>
<td>Product Name</td>
<td>32</td>
<td>Null terminated string that identifies the product corresponding to the dock.</td>
<td>NULL string</td>
<td>EZ-PD Dock</td>
</tr>
<tr>
<td>Device count</td>
<td>1</td>
<td>Indicates the number of devices, including DMC, used for firmware download (connected to DMC). It should never be made zero (at least the DMC device must be supported).</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Reserved</td>
<td>11</td>
<td>Reserved for future use</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The following fields will be repeated for each device.

<table>
<thead>
<tr>
<th>Field</th>
<th>Size (Bytes)</th>
<th>Description</th>
<th>Default Value (Empty CDTT)</th>
<th>Valid CDTT (EZ-PD Dock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>1</td>
<td>Device Types: 0 = Invalid 1 = CCG3 2 = DMC_CY7C65219 3 = CCG4 4 = CCG5 5 = HX3 6 = Invalid 7 – 0xFF = Reserved for future use</td>
<td>0</td>
<td>2 3 5 5</td>
</tr>
<tr>
<td>Component ID</td>
<td>1</td>
<td>Component ID uniquely identifies the component within a peripheral. If a composite device includes two devices of the same type, each will have its own unique component ID. DMC should be the first component; its index should be 0. DMC uses the component ID and device type to uniquely identify any device.</td>
<td>0</td>
<td>0 1 2 3</td>
</tr>
<tr>
<td>Device Image Mode</td>
<td>1</td>
<td>B7: B4 = 0: Single Image 1: Dual images, Symmetric Images 2: Dual images, Asymmetric images 3-0xFF: Reserved/ Invalid</td>
<td>0</td>
<td>1 1 2 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B3:B0 = (Reserved)</td>
<td></td>
<td>1 0 0 0</td>
</tr>
<tr>
<td>Row Size Indicator</td>
<td>1</td>
<td>Row size indicator (multiple of 64 bytes) 1: 64-byte row 2: 128-byte row 4: 256-byte row Other values &gt; Reserved</td>
<td>0</td>
<td>2 4 1 1</td>
</tr>
<tr>
<td>Device Access Type</td>
<td>1</td>
<td>I2C, SPI, UART, … 1: HPI I2C 2: HUB I2C 3: SPI 4: UART 4-0xFF: Reserved</td>
<td>0</td>
<td>NA 1 2 2</td>
</tr>
<tr>
<td>Device Access Port</td>
<td>1</td>
<td>SCB# (0, 1, 2 …) Serial Communication block in the DMC can be configured as either I2C, SPI, or UART. The DMC supports up to 4 SCBs.</td>
<td>0</td>
<td>NA Rev04: 3 Rev05: 0 0 2</td>
</tr>
<tr>
<td>Reserved</td>
<td>2</td>
<td>Reserved for future use</td>
<td>0</td>
<td>0 0 0 0</td>
</tr>
</tbody>
</table>
Access parameters 8  Device-specific access parameters such as the slave address and GPIO (defined in Table 4-2 and Table 4-3 for CCGx and HUB I²C access respectively)  0  NA  See Table 4-2  See Table 4-3  See Table 4-3
Reserved 8  Reserved for future use  0  0  0  0  0

Note: Device Access Port for CCG4 in Rev05 is 0x0.

Table 4-2. CCGx (HPI) I²C Access Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Size (Bytes)</th>
<th>Description</th>
<th>Default Value (Empty CDTT)</th>
<th>Valid CDTT (EZ-PD Dock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>slave address</td>
<td>1</td>
<td>I²C slave address</td>
<td>0</td>
<td>0x08</td>
</tr>
<tr>
<td>HPI intr gpio</td>
<td>1</td>
<td>HPI interrupt GPIO</td>
<td>0</td>
<td>P3.2</td>
</tr>
<tr>
<td>Reserved</td>
<td>6</td>
<td>Reserved</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Note: The CCGx I²C Access needs an additional GPIO as the interrupt GPIO, referred to as HPI INTR GPIO in Table 4-2. The GPIO selected in the CCG4 Dock reference design is P3.2 as used in the EZ-PD Dock board design. The EZ-PD CCG4 USB Type-C Dock board schematics are part of the package <Install Dir>/EZ-PD CCGx Dock SDK/Hardware/CCG4_Dock.

Table 4-3. HUB I²C Access Parameters

<table>
<thead>
<tr>
<th>Field name</th>
<th>Size (Bytes)</th>
<th>Description</th>
<th>Default value (empty CDTT)</th>
<th>Valid CDTT (EZ-PD Dock)</th>
</tr>
</thead>
<tbody>
<tr>
<td>slave address</td>
<td>1</td>
<td>I²C slave address</td>
<td>0</td>
<td>0x51</td>
</tr>
<tr>
<td>reset gpio</td>
<td>1</td>
<td>Hub reset GPIO</td>
<td>0</td>
<td>P3.6</td>
</tr>
<tr>
<td>WP gpio</td>
<td>1</td>
<td>EEPROM write protect GPIO</td>
<td>0</td>
<td>P2.4</td>
</tr>
<tr>
<td>Reserved</td>
<td>5</td>
<td>Reserved</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Note: The HX3 I²C Access needs two additional GPIOs: one as reset GPIO that must be connected to the HX3 Reset pin and another as WP GPIO connected to the WP (Write Protect) pin of the EEPROM (connected to HX3). GPIOs selected in the CCG4 Dock reference design are shown in Table 4-3. The EZ-PD CCG4 USB Type-C Dock board schematics are part of the package <Install Dir>/EZ-PD CCGx Dock SDK/Hardware/CCG4_Dock.

Table 4-4. Billboard Configuration Parameter Definition

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>bb_enable</td>
<td>0 = Billboard interface disabled. 1 = Billboard interface to allow alternate mode status reporting. This is required if upstream CCGx supports user-facing alternate mode.</td>
<td>1</td>
</tr>
<tr>
<td>bb_vendor_enable</td>
<td>0 = Firmware update interface disabled. 1 = Disable vendor interface to allow flashing control. This is required if flashing via USB needs to be supported.</td>
<td>1</td>
</tr>
<tr>
<td>bb_cur_draw</td>
<td>Maximum current drawn by DMC (in units of 2 mA)</td>
<td>0</td>
</tr>
<tr>
<td>bb_bus_power</td>
<td>Power configuration settings to report on USB descriptors</td>
<td>0</td>
</tr>
<tr>
<td>bb_container_id</td>
<td>[ ] = Indicates the unique ID created by the device. (Planned for future implementation). Otherwise the device must use the provided byte array. The size of the array must be 16 bytes.</td>
<td>0</td>
</tr>
<tr>
<td>bb_vid</td>
<td>Vendor ID. VID used for DMC enumeration. Recommended to use the same value as the field &quot;Vendor ID&quot; in CDTT.</td>
<td>0x04B4a</td>
</tr>
</tbody>
</table>

a Caution: 0x04B4 is the Cypress USB Vendor ID (VID) and is used on the EZ-PD CCG4 USB Type-C Dock reference design for demonstration purposes only. Production dock releases, based on this design, are required to use VID of the manufacturer/OEM instead of the Cypress VID. USB VIDs are...
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>bb_pid</td>
<td>Product ID. PID used for DMC enumeration. Recommended to use the same value as the field “Product ID” in CDTT.</td>
<td>0x5220</td>
</tr>
<tr>
<td>us_pd_ctrl</td>
<td>Index of the device within the CDTT config space.</td>
<td>1</td>
</tr>
<tr>
<td>bb_pref_alt_mode</td>
<td>Field is applicable when Billboard is enabled. 0-7: Index into the available set of alternate modes in the order of DSVID and DMODE responses. The device supports up to eight alternate modes.</td>
<td>0</td>
</tr>
<tr>
<td>bb_vconn_power</td>
<td>Field is applicable when Billboard is enabled. Bits [2:0] - 0=1 W, 1=1.5 W, 2=2 W, 3=3 W, 4=4 W, 5=5 W, 6=6 W. Bit [15] - 0=Vconn required, 1=Vconn not required.</td>
<td>0</td>
</tr>
<tr>
<td>bb_mfg_string</td>
<td>Field is applicable when Billboard is enabled. Manufacturer string descriptor.</td>
<td>“Cypress Semiconductor”</td>
</tr>
<tr>
<td>bb_prod_string</td>
<td>Field is applicable when Billboard is enabled. Product string descriptor.</td>
<td>“Billboard Device”</td>
</tr>
<tr>
<td>bb_unique_serial</td>
<td>Field is applicable when Billboard is enabled. 0 = Use string provided from bb_serial_string 1 = Use internally created unique serial number.</td>
<td>1</td>
</tr>
<tr>
<td>bb_serial_string</td>
<td>Field is applicable when Billboard is enabled. Serial number string descriptor.</td>
<td>“”</td>
</tr>
<tr>
<td>bb_config_string</td>
<td>Field is applicable when Billboard is enabled. Configuration string descriptor.</td>
<td>“Billboard Configuration”</td>
</tr>
<tr>
<td>bb_billboard_inf_string</td>
<td>Field is applicable when Billboard is enabled. Billboard interface string descriptor.</td>
<td>“Billboard Interface”</td>
</tr>
<tr>
<td>bb_vendor_inf_string</td>
<td>Field is applicable when Billboard is enabled. Vendor interface string descriptor.</td>
<td>“Vendor Interface”</td>
</tr>
<tr>
<td>bb_additional_url_string</td>
<td>Field is applicable when Billboard is enabled. Billboard additional URL string descriptor.</td>
<td>“www.cypress.com/Type-C/”</td>
</tr>
<tr>
<td>bb_alt_string_array</td>
<td>Field is applicable when Billboard is enabled. Valid only for existing alternate modes. Up to eight alternate modes supported. The index is as per the SVID and MODE information in the D_SVID and D_MODE responses.</td>
<td>[‘Type-C Alternate Mode’]</td>
</tr>
<tr>
<td>bb_alt_mode_svid</td>
<td>Field is applicable when Billboard is enabled. List of SVIDs used in D_SVID response.</td>
<td>[0xFF01]</td>
</tr>
<tr>
<td>bb_alt_mode_index</td>
<td>Field is applicable when Billboard is enabled. List of alternate mode indexes used in D_MODE response</td>
<td>[1]</td>
</tr>
<tr>
<td>bb_alt_mode_vdo</td>
<td>Field is applicable when Billboard is enabled. List of alternate mode VDOs used in D_MODE response</td>
<td>[0x00000000]</td>
</tr>
</tbody>
</table>

Note: If the “bb_enable” is set to 0, then user has to change the “bb_prod_string” to vendor interface. Otherwise they will see the Vendor interface in the name of Billboard Device. Windows will take the product string as the interface name if it has only 1 interface enabled. This is the windows behavior.

assigned and maintained by USB Implementers Forum, Inc. (USB-IF). The USB-IF recommends that each manufacturer/OEM set up a coordinated allocation scheme for Product IDs (PIDs) so that different teams do not inadvertently choose the same PID for different products of the same manufacturer/ OEM. For more information on USB-IF membership and on how to obtain a VID, visit [http://www.usb.org](http://www.usb.org). Contact Cypress customer support for any further clarifications.
4.4 EZ-PD Dock Image Creation Tool

The EZ-PD Dock Image Creation Tool is used to create a single combined firmware image file, referred to as the composite dock image (.bin) from firmware files of components present in the dock (see Figure 4-2).

Figure 4-2. EZ-PD Dock Image Creation Tool

- The EZ-PD Dock Image Creation Tool accepts the dock topology information in Dock Config XML file format. The template Dock Config XML file accepted by the tool is a part of the package and can be found at the location <Install Dir>/EZ-PD CCGx Dock SDK/Software Tools/CCG4_Dock/CY7C65219-40LQXI_dock_config.xml.

  Note: The same XML (the Dock Config XML) file format is used for the EZ-PD Dock DMC Configuration Generation Tool and EZ-PD Dock Image Creation Tool for ease of use. Relevant parameters needed by the respective tools are read and used. Update the Dock Config XML file to suit the dock design once and reuse it across various tools. Follow the comments in the Dock Config XML file to update it.

- By design, every device must support dual images (primary and secondary image) with one image as a fail-safe copy. In this way, the dock functionality will always be intact even if the data integrity check fails for one of the image copies for any of the dock devices.

- The EZ-PD Dock Image Creation Tool extracts the necessary metadata from individual images and adds them to the composite dock image. This metadata information is referred to as Firmware config table (FWCT).

The input firmware image files as well as the Dock Config XML file are parsed and relevant information from either is extracted to form the FWCT and the composite image (see Section 4.4.1) formed in the same order as the devices are listed in the dock topology table, and CDTT in the Dock Config XML file. When these image files are parsed to extract the binary image out of them, SHA-256 hash is computed for each image and added to the FWCT. At the end of the file parsing operation, output files are generated.

4.4.1 Single Composite (Combined) Dock Image

Figure 4-3 shows an example of the composite image format that is generated from the EZ-PD Dock Image Creation Tool. Figure 4-3 shows an example use-case where each device consists of dual images. If any of the device image contains data which happens to be discontinuous in the physical memory, then the image is logically broken down into multiple segments. Accordingly, DMC and the associated tools keep track of all related information like the segment start address, segment size etc. which are required to download the respective segments into the actual physical memory during firmware update. In Fig 4-3, device 1 and device 2 consist of dual images, each with two segments; device N has dual images, each with one segment.

Note that the images shown in Figure 4-3 are in bin format, containing only the binary data. Any information present in the cyacd/ hex file formats such as row number and checksum are removed.
4.5 EZ-PD Dock Firmware Update Tool

The EZ-PD Dock Firmware Update Tool is a WinUSB-based application that runs on Windows systems. This tool updates firmware for devices in the dock and reports the final consolidated status. It takes the files generated using the EZ-PD Dock Image Creation Tool as the input and initiates a firmware update.

4.6 Firmware Update Tools Overview

Figure 4-4 shows the consolidated view of the firmware update process using software tools.

1. The EZ-PD Dock DMC Configuration Generation Tool takes the Dock Config XML file with a valid CDTT, other configuration space parameters and DMC images as the input. This tool creates updated DMC images as the output with modified configuration space parameters.

2. The EZ-PD Dock Image Creation Tool takes the Dock Config XML file with valid CDTT parameters and all the relevant firmware images for the various dock devices/components as input and creates a single composite dock image (.bin) as the output. It also generates an additional file (.cfg) with only the FWCT parameters, which is unused in a normal unsigned firmware update flow.
**Note:** The input Dock Config XML file also contains the paths to dock component images, which are used by the EZ-PD Dock Image Creation Tool to get the firmware images of the relevant dock components.

3. The EZ-PD Dock Firmware Update Tool takes the composite dock image generated in Step 2 and communicates with the DMC within the dock to update the firmware.

4. The firmware is updated in the dock components over the USB vendor interface.

### 4.6.1 Updating DMC Configuration

**Figure 4-5** shows the Help information displayed for the EZ-PD Dock DMC Configuration Generation Tool. The Help text shows the syntax to invoke the tool.

![Figure 4-5. EZ-PD Dock DMC Configuration Generation Tool Help](image)

**Note:** The version number of the tool displayed while invoking the tool may vary from the version number shown in screen images.

1. Ensure that the following fields are updated correctly in the Input Dock Config XML file. The template Dock Config XML file is a part of the package and can be found at the location `<Install Dir>/EZ-PD CCGx Dock SDK\Software Tools\CCG4_Dock\CY7C65219-40LQXI_dock_config.xml`.

**Note:** Ensure the Read-Only attribute of `CY7C65219-40LQXI_dock_config.xml` is not set. If set, change that to make it editable.

**Note:** Copy the reference design contents from `<Install Dir>/EZ-PD CCGx Dock SDK\` to `<Custom Dir>/EZ-PD CCGx Dock SDK\`, which allows to edit files and save them without admin rights. “Custom Dir” must be outside `C:\Program Files` to allow the files to be edited and saved.

- The `fw_version_check` field (see **Figure 4-6**) must be set appropriately based on the application requirements. See Section 4.8 for more details on the difference between the firmware update mechanism with version check enabled and disabled.

![Figure 4-6. DMC Configuration – Firmware Version Check](image)

- The `valid` field (see **Figure 4-7**) should contain a non-zero value to ensure that a valid CDTT is placed in the DMC configuration space. It is recommended to use the same value as in the template Dock Config XML file, which contains the latest value supported by the DMC firmware. This field also stands for the CDTT structure version used internally by the firmware.
Update other dock identification parameters and `cdtt_version` as shown in Figure 4-7. More detailed instructions can be found in the comments in the Input Dock Config XML file.

Populate the `dev_info` nodes to reflect the dock topology information (static information related to the dock such as dock identification, number of devices connected to DMC, DMC interface (I²C/ SPI/ UART) over which the DMC can update the device firmware, and the DMC port number connected to the respective device). Refer to Section 4.7 for more details on populating these fields. Figure 4-8 shows the populated device nodes corresponding to the DMC and CCG4 in the CCG4 Dock reference design. There is no change in the Dock Topology for Hardware revision 4 and revision 5 except the CCG4 access port.
2. After the input Dock Config XML file is updated, invoke the tool as follows:

Example:
```
>ezpd_dockconfiguredmc.exe -i CY7C65219-40LQXI_dock_config.xml
```

Figure 4-9 shows the output of the EZ-PD Dock DMC Configuration Generation Tool after generating the modified DMC image, which is mentioned in the XML file. If the DMC images are not given in the XML file, the tool will generate only the configuration table(config.c). User can use this modified configuration table and build the DMC application.

Note:
1. The complete path/file name of the CYACD file as well as Dock Config XML file must be mentioned in the above step.
2. The version numbers of the firmware images displayed while invoking the tool may vary from the version numbers shown in screen images.
4.6.2 Dock Image Creation

Figure 4-10 shows the help information displayed for the EZ-PD Dock Image Creation Tool, showing the syntax to invoke the tool.

Figure 4-10. EZ-PD Dock Image Creation Tool Help

1. Ensure that the following fields are updated correctly in the Input Dock Config XML file.
   - The `dig_sig_algo` field should be assigned the value ‘0’ for unsigned firmware update. Contact Cypress for support for signed firmware update.

   Figure 4-11. DMC Configuration – Digital Signature Algorithm

   - The `fwct_version` field should not be modified unless a FWCT structure version change is notified by Cypress.

   - Increment the `composite_fw_version` for every composite dock image to be created.

   - Populate the paths to the respective dock component images. See the Input Dock Config XML comments for more instructions. Figure 4-12 shows the DMC image paths specified in the device node corresponding to the DMC. You must ensure that the correct file name with the right extension for the particular device is specified in the correct order.
2. Invoke the tool as follows:

Example:

```bash
>ezpd_dockcreateimage.exe -i CY7C65219-40LQXI_dock_config.xml -o composite
```

Figure 4-13 shows the output of the EZ-PD Dock Image Creation Tool after generating the composite dock image, `composite.bin`. In this example, the Dock Config XML file used for generating the composite doc image file is `CY7C65219-40LQXI_dock_config.xml`, which is the same as the file used in Section 4.6.1. This Dock Config XML file contains the paths to dock component images: DMC, CCG4, and HX3(s) in this design.

Figure 4-13. EZ-PD Dock Image Creation Tool Operation
Figure 4-14 shows the output of the EZ-PD Dock Image Creation Tool after generating the same set of dock composite images as shown in Figure 4-13, but with a detailed log option. This tool can be invoked as follows for detailed logging:

Example:

```
> ezpd_dockcreateimage.exe -i CY7C65219-40LQXI_dock_config.xml -o composite -l v
```

![Figure 4-14. EZ-PD Dock Image Creation Tool Operation (Detailed Log)](image)

**Note:** The version numbers of the firmware images displayed while invoking the tool may vary from the version numbers shown in screen images.
4.6.3 Dock Firmware Update

Figure 4-15 shows the Help information displayed for the EZ-PD Dock Firmware Update Tool, showing the syntax to invoke the tool.

Figure 4-15. EZ-PD Dock Firmware Update Tool Help

Syntax of tool is

```
$ezpd_dockupdatefw.exe [-i <FILE NAME>] [-v] [-h]
[-vid <VID>] [-pid <PID>] [-l <LOG OPTION>]
[-t <RE-ENUMERATION TIME OUT>]
[-ct <CONNECTION TIME OUT>]
```

- `-i`: Specify file name for the composite dock image.
  (This option is ignored if `-v` or `-h` option is present.)
- `-v`: Prints the fw version information.
- `-h`: Displays this help information.
- `-vid`: Specify the VID value of DMC in hex (Default = 0x4B4).
- `-pid`: Specify the PID value of DMC in hex (Default = 0x5220).
- `-l`: Specify logging level (q = quiet/minimal, v = verbose)
  (Default = v).
- `-t`: Specify the re-enumeration time out value in ms (Default = 60000)
- `-ct`: Specify the connection time out value in ms (Default = 15000)
- `-reset`: Reset the device.

Figure 4-16 shows how the dock status query output appears in the case of a DMC with the factory-default DMC firmware (that has an empty CDTT). It shows the dock firmware status as “Factory” and the composite firmware version as “0.0.0.0” because no firmware update had been done since then, and the DMC is running the factory-default firmware. It also shows the extensive status information of DMC images along with their individual firmware versions.

1. After connecting the upstream port of a powered EZ-PD Dock board to a Windows PC that is running the EZ-PD Dock One Click Firmware Update Tool, invoke the tool as follows for querying the dock status.

   **Note:** Refer to section 4.7.1 for more details on the EZ-PD Dock connection and DMC enumeration.

   Example:

```
>ezpd_dockupdatefw.exe -v -vid 04B4 -pid 5220
```

VID/PID parameters passed are the same as the VID/PID parameters of the DMC vendor/billboard interface in the EZ-PD reference design: 0x04B4/ 0x5220. Figure 4-16 shows how the dock status query output appears in the case of a DMC with the factory-default DMC firmware (that has an empty CDTT). It shows the dock firmware status as “Factory” and the composite firmware version as “0.0.0.0” because no firmware update had been done since then, and the DMC is running the factory-default firmware. It also shows the extensive status information of DMC images along with their individual firmware versions.

Figure 4-16. EZ-PD Dock Firmware Update Tool Dock Status Query – Factory-Default DMC

```
**Figure 4-17** shows how the dock status query output appears in the case of a DMC with a valid CDTT corresponding to the CCG4 Dock reference design.

**Figure 4-17. EZ-PD Dock Firmware Update Tool Dock Status Query – With Valid CDTT**

![Dock Status Query Output](image)

---

**C:\EZ-PD Dock Reference Design\Software Tools\ezpd_dockupdatefw.exe** -v "vid 04B4 -pid 5220"

<table>
<thead>
<tr>
<th>Dock IDENTIFY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dock version</td>
</tr>
<tr>
<td>UID</td>
</tr>
<tr>
<td>VID</td>
</tr>
<tr>
<td>Vendor</td>
</tr>
<tr>
<td>Product</td>
</tr>
<tr>
<td>Signed FW Update</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CURRENT Dock STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last FW update status</td>
</tr>
<tr>
<td>Device count</td>
</tr>
<tr>
<td>Composite dock image version</td>
</tr>
</tbody>
</table>

---

**Device1**

- **Device type**: DMC
- **Component ID**: 0
- **Current Image**: Image-1
- **Bootloader Version**
  - Base Version: 3.1.0.1073
  - Application Version: dn.0.0.1

**Device2**

- **Device type**: CCG4
- **Component ID**: 1
- **Current Image**: Image-1
- **Bootloader Version**
  - Base Version: 3.1.0.1115
  - Application Version: md.0.0.1

**Device3**

- **Device type**: HK3
- **Component ID**: 2
- **Current Image**: Image-0
- **Bootloader Version**
  - Image-0 Status: VALID
  - Version: 0.1.1.103

**Device4**

- **Device type**: HK3
- **Component ID**: 3
- **Current Image**: Image-0
- **Bootloader Version**
  - Image-1 Status: VALID
  - Version: 0.1.1.103

---

Connection to DMC closed.

Exiting the application.
2. Invoke the tool as follows for initiating a firmware update:

Example:

```
>ezpd_dockupdatefw.exe -i composite.bin -vid 04B4 -pid 5220
```

The dock composite image used for the update is `composite.bin`, generated by the EZ-PD Dock Image Creation Tool in section 4.6.1. Figure 4-18 shows the output of the EZ-PD Dock Firmware Update Tool after initiating the firmware update of the dock. It shows the instance when the tool was invoked and the firmware update is in progress. Extensive dock status information and all devices’ firmware versions and current running firmware are shown in the console before starting the firmware update. Figure 4-18 shows the DMC firmware image 0 being updated.

**Note:** While downloading the firmware using the EZ-PD Dock Firmware Update tool, following are the recommended practices:

- Power to the EZ-PD CCG4 USB Type-C Dock hardware is not removed.
- The USB cable connected between the CCG4 Dock and the PC is not detached from the PC.

![EZ-PD Dock Firmware Update Tool Operation – In Progress](image)

Figure 4-18. EZ-PD Dock Firmware Update Tool Operation – In Progress
Figure 4-19 shows how the firmware update is completed. Extensive dock status information and all devices' firmware versions and current running firmware are shown in the console after completing the firmware update. You can verify the firmware version of the various devices in the dock as shown in Figure 4-19 where device images are "VALID" after the firmware update; therefore, the update cycle was completed successfully.

Note: The firmware update cycle undergoes one or more re-enumerations to update the various images of the dock components. Firmware update logic always updates only the alternate firmware and not the current running firmware, which in turn causes a switch in the device running the firmware during the update process.

Figure 4-19. EZ-PD Dock Firmware Update Tool Operation – Complete
Figure 4-20 shows an example of when the firmware update failed. Extensive dock status information in Figure 4-20 shows that the image 0 of DMC is invalid. The cause of the failure can be an incorrect/corrupt DMC image 0 (which cannot be solved with firmware update retry), any power glitch, or other unknown reasons (which might be solved with a firmware update retry).

Figure 4-20. EZ-PD Dock Firmware Update Tool Operation – Failed

Writing HK3 (Comp-id: 3), Image-0 image
Waiting for FU upgrade request
Received re-enumeration notification
DMC disconnected, waiting for re-connecting DMC
Re-connected to the DMC
Starting FU upgrading
Sending start command
Waiting for FU upgrade request
Writing CCG4 (Comp-id: 1), Image-1 image

Waiting for FU upgrade request
Finished FU update process with status COMPLETED PARTIALLY
DMC disconnected, waiting for re-connecting DMC
Re-connected to the DMC
Current FU update status: Failed
Device count: 3
Composite dock image version: 0.0.0.1

---

Device#3
Device type: DMC
Component ID: 0
Current image: Image-1
Bootloader Version
Base Version: 3.1.0.1073
Application Version: da.0.0.0.1
Image-0 Status: INVALID
(<last known good versions>)
Base Version: 3.0.0.962
Application Version: da.1.0.1
Image-1 Status: VALID
Base Version: 3.0.0.962
Application Version: da.1.0.1

---

Device#1
Device type: CCG4
Component ID: 1
Current image: Image-1
Bootloader Version
Base Version: 3.1.0.1151
Application Version: da.0.0.0.1
Image-0 Status: VALID
Base Version: 3.1.1.1312
Application Version: md.1.1.0.8
Image-1 Status: VALID
Base Version: 3.1.1.1312
Application Version: md.1.1.0.8

---

Device#2
Device type: HK3
Component ID: 2
Current image: Image-0
Bootloader Version
Image-0 Status: VALID
Version: 0.1.1.183
Image-1 Status: VALID
Version: 0.1.1.183

---

Device#3
Device type: HK3
Component ID: 3
Current image: Image-0
Bootloader Version
Image-0 Status: VALID
Version: 0.1.2.183
Image-1 Status: VALID
Version: 0.1.2.183

---

Connection to DMC closed.
Exiting the application.
4.6.4 USB Serial Number Update Tool

Serial number is used to uniquely identify a USB device. Usually, serial number programming will be used the factory process. This is not mandatory and not required for firmware update. If you want to have a unique serial number for the Cypress dock components, you can use the Serial Number Update Tool to update the custom serial number. The tool (DockSerialNumberUpdateTool.exe) is in the <Install Dir>/EZ-PD CCGx Dock SDK/Software Tools/CCG4_Dock directory.

To enable this feature, the DMC project must be compiled with the USR_DEFINED_SN_SUPPORT option enabled. This feature is enabled by default. See the Help option in the tool by invoking the tool with the following option:

```
DockSerialNumberUpdateTool.exe -vid <vid of the dock> -pid <pid of the device> -sn <serial number> -t <timeout period>
```

The Serial Number used must be reported as the serial number for all the HX3 Hubs and DMC. The serial number will be used to uniquely identify the dock board and not a dock component. Note that this feature does not support non-Cypress Hubs (HX3).

After the serial number update is successful, you can verify the updated serial number in the following ways:

1. In Device Manager, right-click the corresponding USB device and open the "Properties" windows. Select the Details tab and select the "Driver Instance Path". You can see the new serial number appended there after the VID/PID information.

2. Open the USB View/USB Tree View application and select the corresponding USB Device in the left tab. The right tab will display the details of the selected USB Tree; you can verify the Serial number.

Note: The total length of the string descriptor including Language ID, Manufacturer string, Product string and Serial Number is 152 bytes for HX3 Hubs. The maximum allowed serial number string length for DMC is 126 bytes.

4.7 Quick Start on EZ-PD CCG4 USB Type-C Dock Firmware Update

The reference batch scripts are provided as part of the package and can be found in <Install Dir>/EZ-PD CCGx Dock SDK/Software Tools/CCG4_Dock. Copy the reference design contents from <Install Dir>/EZ-PD CCGx Dock SDK to <Custom Dir>/EZ-PD CCGx Dock SDK, which allows to edit files and save them without admin rights. The script files are numbered in the order it is expected to be run.

Note: "Custom Dir" must be outside "C:/Program Files" to allow the files to be edited and saved.

4.7.1 Query Dock Status

1_dock_status_query.bat is a shell script, which illustrates how the EZ-PD Dock Firmware Update Tool can be used to query the current dock status any time.
1. Power the CCG4 Dock board, and connect the upstream port (Type-C upstream port in CCG4 Dock Reference design) to a Windows PC that is running the EZ-PD Dock One Click Firmware Update Tool.

   **Note:** If the Windows PC supports Type-C ports, connect the Type-C upstream using Type-C to Type-C cable; if not, connect using a Type-C to Type-A cable.

2. Ensure that the DMC device enumerates as a WinUSB device (Figure 4-21) from Device Manager.

   ![Figure 4-21. DMC Enumerates as WinUSB Device](image)

   **Note:**

   1. When connecting to a port for the first time, enumeration of the DMC may take longer (few minutes) depending on the USB tier. In the CCG4 Dock Reference design, the DMC is under the Tier 1 USB 3.0 Hub. Refer to the EZ-PD Reference Design board schematics (<Custom Dir>/EZ-PD CCGx Dock SDK/Hardware/CCCG4_Dock).

   2. In Windows 7 systems, the WinUSB drivers were not seen to be binding without internet connectivity due to a known issue with Windows 7. Windows 7 ships with the correct 'winusb.sys' file, but is missing an updated '.inf' file that associates the driver with "usb\msc\winusb" devices. Microsoft provides a fix for this through Windows update. Depending on the update policy for the Windows 7 PC, the appropriate driver may be already available on the machine. If it is not already on the PC, do the following to install the driver:


      b. Download "Windows Phone - Other hardware - WinUsb Device".

      c. Extract the contents of the downloaded '.cab' file to a temporary folder.

      d. In the Device Manager, select Update driver software > Browse my computer for driver software.

      e. Navigate to the temporary folder with the downloaded driver and complete the installation.

      Alternatively, winusb binding to the DMC device or any WinUSB device in the PC can be corrected using the Driver Package Installer (DPInst). DPInst automatically updates the drivers for any installed devices that are supported by the newly installed driver packages and can be obtained with Windows Driver Kit (WDK):


3. Run the 1_dock_status_query.bat file. The current status of the dock is displayed as shown in Figure 4-22.
4.7.2 Configure DMC Images

1. Run the `2_copy_fw_image_files.bat` file to copy the relevant firmware (DMC, CCG4, HX3 Tier 1 and Tier 2) images from the respective locations under `<Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries` to `<Custom Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries`.

   ![Figure 4-23. 2_copy_fw_image_files.bat Output](image)

   **Figure 4-23. 2_copy_fw_image_files.bat Output**

2. Run `3_dmc_config GENERATION.bat` to create DMC firmware images (cyacd files) with the modified configuration to generate DMC firmware images with the modified configuration containing a valid CDTT (see Figure 4-24).

   ![Figure 4-24. Generate DMC Firmware Images with Valid CDTT](image)

   **Figure 4-24. Generate DMC Firmware Images with Valid CDTT**

**Notes:**

1. The new DMC firmware images (cyacd files) will be created with the same name as the old ones, overwriting old DMC firmware images.
2. The `CY7C65219-40LQXI_dock_config.xml` file is already modified to have valid CDTT values for the CCG4 Dock reference design.
4.7.3 Create Dock Composite Image

1. Run the `4_image_creation_script.bat` file to create the composite dock image, `composite.bin`, by including DMC, CCG4, and HX3 (Tier 1 and Tier 2) firmware images (see Figure 4-25).

   **Note:** The `composite.cfg` file also is generated; however, this file is not used.

---

**Figure 4-25. Create Composite Dock Image**

```plaintext
Initializing Composite Dock Image Creation for EZ-PD Dock...

---

Dock config xml file
Dock config xml loaded successfully
Starting image creation

Copying image0
Copied segment0
Base version : 3.0.0.762
Application Version : dm.1.0.1

Copying image1
Copied segment1
Base version : 3.0.0.762
Application Version : dm.1.0.1

Copying image2
Copied segment2
Base version : 3.1.1.1312
Application Version : md.1.0.0

Copying image3
Copied segment3
Base version : 3.1.1.1312
Application Version : md.1.0.0

Copying image4
Copied segment4
Base version : 0.1.1.183

Copying image5
Copied segment5
Base version : 0.1.1.183

Copying image6
Copied segment6
Base version : 0.1.2.103

Copying image7
Copied segment7
Base version : 0.1.2.103

Composite image generated successfully
Exiting the application
```

Press any key to continue...
4.7.4 Dock Firmware Update

1. Ensure the CCG4 Dock is connected to the Windows PC, containing EZ-PD Dock Firmware Update Tool.

2. Run the 5_one_click_update_tool.bat file to start the dock firmware update using the EZ-PD Dock Firmware Update Tool (see Figure 4-26). Wait until the firmware update completes as shown in Figure 4-27.

Figure 4-26. Dock Firmware Update Started

```
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
Figure 4-27. Dock Firmware Update Completed

Starting FW upgrading
Sending start command
Waiting for FW upgrade request
Writing CGG4 (Comp-id: 1) Image-1 image

Waiting for FW upgrade request
Finished FW update process with status COMPLETED
DMC disconnected, waiting for re-connecting DMC

Device list

Device 1
- Device type: DMC
- Component ID: 0
- Current image: Image-1

Device 2
- Device type: CCG4
- Component ID: 1
- Current image: Image-1

Device 3
- Device type: HK3
- Component ID: 2
- Current image: Image-0

Device 4
- Device type: HK3
- Component ID: 3
- Current image: Image-0

Dock Firmware Update Completed

Connection to DMC closed.
Exiting the application

Press any key to continue . . .
4.8 Firmware Update Logic

Per the application requirement, firmware update can be enforced with version check enabled or disabled.

4.8.1 Firmware Version Check Disabled

When firmware version check is disabled in the configuration space of DMC, the update will happen using the following logic.

Update of all device images present in the composite dock image will be invoked by DMC irrespective of the firmware already residing in the device. This enables downgrading the firmware to an older version if needed. This also allows updates to be retried multiple times using the same composite dock image, even if it was already updated using the same composite dock image successfully before. During the development phase of any new dock design, this can be left disabled to enable easy updates or downgrades of any device firmware.

4.8.2 Firmware Version Check Enabled

Caution: It is not recommended to enable version check without taking assistance from Cypress because any further updates will require device images with incremental firmware versions. It is not possible to increment the firmware version of DMC and CCG4 images without contacting Cypress. The logic used in the dock update flow with version check enabled is explained here for understanding purpose only.

When the firmware version check is enabled in the configuration space of DMC, the update happens as follows:

1. Update of all device images present in the composite dock image will be invoked by DMC if the new composite dock image's composite image version is greater than the current composite image version in the dock.

   Note: Current composite image version in the dock can be obtained by querying the dock status. Invoke the tool as follows for querying the dock status. New Composite dock image’s composite image version must be set as a higher value in the Dock Config XML file while creating the composite dock image as explained in Section 3.6.2.

   Example:

   ```
   >ezpd_dockupdatefw.exe -v -vid 04B4 -pid 5220
   ```

   Figure 4-28. EZ-PD Dock Firmware Update Tool Dock Status Query – Factory-Default DMC

   ```
   Ez-PD Dock Reference Design\Software Tools>ezpd_dockupdatefw.exe -v -vid 04B4 -pid 5220
   Connecting to the DMC
   Current Dock Status
   Device name: Factory
   Composite dock image version : 8.0.0.0
   ```

   If the composite version check in step 1 fails, firmware update will fail with the following message from the DMC:

   “DMC responded with FW cfg table analysis status: invalid composite version”.

2. If the composite version check in Step 1 succeeds, DMC will check for the image to be updated (starting with the first image in the composite dock image) from the composite dock image and check whether the corresponding image of the device in the dock is valid.

   a. If found to be valid, update will be initiated only if the firmware version of the new image for the device is greater than the firmware version of the corresponding image of the particular device.

   b. If found to be invalid, update will be initiated only if the firmware version of the new image for the device is greater than or equal to the last known good firmware version of the corresponding image of the particular device (which will also be shown while querying the dock status). If it is found that the device image update is not needed, then DMC proceeds to check the next device image in the composite dock image.

3. Step 2 is repeated for every image of every device found in the composite dock image.
4. Once all images in the composite dock image are successfully updated (if required as described in Step 2), DMC indicates the status of the update as successful to the EZ-PD Dock Firmware Update Tool. The tool will display the message “Finished FW update process with status COMPLETED”. This in turn reflects as Current FW update status “Complete.”

a. Only on a successful update, the composite dock image version update to show the new composite dock image version from the composite dock image (bin) file (see Figure 4-29). Individual device images’ firmware versions will also reflect the new updated values.

b. If any device image update fails, the tool displays the message “Finished FW update process with status COMPLETED PARTIALLY” and the Current FW update status as “Failed”. In such cases, the composite dock image version is not updated and still shows the version as it had in Step 1 before starting the update. Thus, the failed image update can be retried by invoking the update again using the same composite dock image file. DMC updates only those images which were not updated in the last attempt.

c. If any image update continues to fail on multiple attempts, contact Cypress for further assistance.

---

Figure 4-29. EZ-PD Dock Firmware Update Tool Operation – Complete

```
Writing MX3 (Comp-id: 2), Image-0 image
Waiting for FW upgrade request
Writing MX3 (Comp-id: 2), Image-0 image
Waiting for FW upgrade request
Received re-enumeration notification
DMC disconnected, waiting for re-connecting DMC
Re-connected to the DMC
Starting FW upgrading
Waiting for FW upgrade request
Writing CCG4 (Comp-id: 1), Image-1 image
Waiting for FW upgrade request
Finished FW update process with status COMPLETED
DMC disconnected, waiting for re-connecting DMC
Reconnected to the DMC
--------------------------CURRENT DOCK STATUS--------------------------
Current FW update status : Complete
Device count : 4
Composite dock image version : 0.0.0.1

<table>
<thead>
<tr>
<th>Device#0</th>
<th>Device type</th>
<th>DMC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Component ID</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Current image</td>
<td>Image-1</td>
</tr>
<tr>
<td></td>
<td>Revision</td>
<td>3.1.0.1073</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image-0</th>
<th>Status</th>
<th>VALID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Version</td>
<td>3.0.0.762</td>
<td></td>
</tr>
<tr>
<td>Application Version</td>
<td>dm.1.0.1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image-1</th>
<th>Status</th>
<th>VALID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Version</td>
<td>3.0.0.762</td>
<td></td>
</tr>
<tr>
<td>Application Version</td>
<td>dm.1.0.1</td>
<td></td>
</tr>
</tbody>
</table>
```

---

4.8.3 Update Logic and Versioning Scheme

4.8.3.1 DMC

DMC has 128 KB flash memory, which is designed to store a Bootloader and two copies of the application firmware images. At any given instant, the DMC CPU runs from one image of the firmware (either Image-0 or Image-1), whichever was last updated, while the system can upgrade the other copy of the DMC firmware not being used at the time. If one of the DMC application firmware images gets corrupted, the system is always left with the other (alternate) image as the VALID/ running image.

The DMC firmware versioning scheme uses an 8-byte unsigned value to uniquely identify the DMC firmware, with 4 bytes denoting the base firmware stack version and 4 bytes denoting the DMC application firmware version. DMC Bootloader and both copies of DMC application firmware (Image-0 and Image-1) maintains separate 8 bytes of firmware version each.

4 bytes Base firmware stack version is of the format:
- Bytes 1-0: Build number
- Byte 2: Patch version
- Byte 3 (Bits 0:3): Minor Version
- Byte 3 (Bits 4:7): Major Version

4 bytes DMC application firmware version is of the format:
- Bytes 1-0: Application type string ("dm")
- Byte 2: Sub minor number
- Byte 3 (Bits 0:3): Minor Version
- Byte 3 (Bits 4:7): Major Version

4.8.3.2 CCG4

CCG4 has 128 KB flash memory, which is designed to store a Bootloader and two copies of the application firmware images. At any given instant, the CCG4 CPU runs from one image of the firmware (either Image-0 or Image-1), whichever was last updated, while the system can upgrade the other copy of the CCG4 firmware not being used at the time. If one of the CCG4 application firmware images gets corrupted, the system is always left with the other (alternate) image as the VALID/ running image.

The CCG4 firmware versioning scheme uses an 8-byte unsigned value to uniquely identify the CCG4 firmware, with 4 bytes denoting the base firmware stack version and 4 bytes denoting the CCG4 application firmware version. The CCG4 Bootloader and both copies of CCG4 application firmware (Image-0 and Image-1) maintain 8 separate bytes of firmware version each.

4 bytes Base firmware stack version is of the format:
- Bytes 1-0: Build number
- Byte 2: Patch version
- Byte 3 (Bits 0:3): Minor Version
- Byte 3 (Bits 4:7): Major Version

4 bytes CCG4 application firmware version is of the format:
- Bytes 1-0: Application type string ("md")
- Byte 2: Sub minor number
- Byte 3 (Bits 0:3): Minor Version
- Byte 3 (Bits 4:7): Major Version

4.8.3.3 HX3

HX3 uses external I2C EEPROM for booting the firmware. The CCG4 Dock reference design uses 32-KB external EEPROM that stores two copies of the HX3 application firmware images (Image-0 as primary image and Image-1 as secondary image). The HX3 bootloader always runs from the primary image (Image-0) unlike DMC or CCG4 devices. If the primary (Image-0) firmware image gets corrupted, DMC recovers the primary image (Image-0) from the secondary image (Image-1) on the very next power cycle.
The HX3 firmware versioning scheme uses a 4-byte unsigned value of the format:

- **Byte 0**: Hard coded as “0xB7” representing the HX3 Silicon version
- **Byte 1**: HX3 Tier number in the dock design
- **Byte 2**: HX3 firmware Minor version
- **Byte 3**: HX3 firmware Major version

### 4.9 Extending the EZ-PD Dock Design

Figure 4-30 shows how the EZ-PD CCG4 USB Type-C Dock design can be extended to include more devices and components in the dock. Similarly, dock components can also be removed or restructured based on the application. With these changes, dock components’ firmware can still be updated using the DMC and EZ-PD Dock Firmware Update Tool.

![Figure 4-30. DMC Updates Dock Components’ Firmware over I2C](image)

#### 4.9.1 Defining the New Dock Design

For the new dock design, the dock topology information must be carefully laid out from the perspective of the DMC in the format as defined in Table 4-1. The dock topology can be filled in by answering the following questions. Answers to the questions should be translated as the corresponding values in the Input Dock Config XML file. The template Dock Config XML file is part of the package and can be found at the location `<Install Dir>/EZ-PD CCG4 USB Type-C Dock SDK\Software Tools\CCG4_Dock\CY7C65219-40LQXI_dock_config.xml`.

- **What must be VID, PID, DID (Vendor ID, Product ID, and Device ID fields in Table 4-1) identifying the new dock design?** The answers should go into the `vid`, `pid`, and `dev_id` fields of the Dock Config XML file, respectively.

  **Note**: 0x04B4 is the Cypress USB Vendor ID (VID) and is used on the EZ-PD CCG4 USB Type-C Dock reference design for demonstration purposes only. Production dock releases, based on this design, are required to use VID of the manufacturer/OEM instead of the Cypress VID. USB VIDs are assigned and maintained by USB Implementers Forum, Inc. (USB-IF). The USB-IF recommends that each manufacturer/OEM set up a coordinated allocation scheme for Product IDs (PIDs) so that different teams do not inadvertently choose the same PID for different products of the same manufacturer/OEM. For more information on USB-IF membership and on how to obtain a VID, visit [http://www.usb.org](http://www.usb.org). Contact Cypress customer support for any further clarifications.

- **What must be the Vendor and Product string (Vendor Name and Product Name fields in Table 4-1) identifying the new dock design?** The answers should go into the `vend_name` and `prod_name` fields of the Dock Config XML file, respectively.

- **How many devices (Device count field in Table 4-1) in total are connected to the DMC and thus can be updated through the DMC?** The answer should go into the dev_count field of the Dock Config XML file.

After identifying the total number of devices connected to the DMC, answer the following set of questions for each device. Each device corresponds to one dev_info node in the Dock Config XML file.

- **What is the type of the device (Device Type field in Table 4-1) that needs to communicate with the DMC?** The answer should go into the dev_type field of the Dock Config XML file.
Note: Device types currently supported in the DMC firmware can be found from Table 4-1. For new device types, contact Cypress.

- Assign an incremental (unique) index (Component ID field in Table 4-1) to the device, which is used by the DMC firmware to uniquely identify the device. The DMC must be the first component and its index must be 0. The answer should go into the comp_id field of the Dock Config XML file.
- What is the image mode of the device (Device Image Mode field in Table 4-1)? The answer should go into the img_mode field of the Dock Config XML file.
- What is the flash/ EEPROM row size (Row Size indicator field in Table 4-1) supported for the device? See Table 4-1, for row sizes currently supported by the DMC firmware. The answer should go into the row_size field of the Dock Config XML file.
- What is the interface protocol (I²C/ SPI/ UART) connecting the device and DMC (Device Access Type field in Table 4-1)? The answer should go into the access_type field of the Dock Config XML file.
  Note: Keep access_type as ‘1’ for any CCGx device.
- What is the SCB port# of DMC that connects to the device (Device Access Port field in Table 4-1)? The answer should go into the access_port field of the Dock Config XML file.
  Note: The DMC supports up to four Serial Communication Blocks (SCB) that can be configured as I²C/ SPI/ UART.
- What are the various access parameters (Access Parameters field in Table 4-1) needed to communicate with the DMC over I²C when the interface protocol is I²C?
- What is the I²C slave address? The answer should go into address field of Dock Config XML.
- What is the GPIO# to be used as in interrupt GPIO in case of CCGx access or reset GPIO or Write Protect GPIO in case of HX3 access? The answer should go into the hpi_intr_gpio, reset_gpio, or wp_gpio field of the XML file, respectively.
  Note: The GPIO must be specified in the Px.y format in the Dock Config XML file where x denotes the DMC port number and y denotes the pin number within the DMC port.

Similarly, populate other Billboard-related parameters in the Dock Config XML file. Refer to Table 4-4 for details.

These questions are summarized in Table 4-5.

Table 4-5. Forming the Dock Topology for New EZ-PD Dock Design

<table>
<thead>
<tr>
<th>Composite Dock Topology Table (CDTT) Entry</th>
<th>Entry Field in Dock Config XML &lt;dock_info&gt;</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor ID</td>
<td>vid</td>
<td>VID, PID, and DID identifying the new dock design</td>
</tr>
<tr>
<td>Product ID</td>
<td>pid</td>
<td></td>
</tr>
<tr>
<td>Device ID</td>
<td>dev_id</td>
<td></td>
</tr>
<tr>
<td>Vendor Name</td>
<td>vend_name</td>
<td>Vendor and Product strings identifying the new dock design</td>
</tr>
<tr>
<td>Product Name</td>
<td>prod_name</td>
<td></td>
</tr>
<tr>
<td>Device count</td>
<td>dev_count</td>
<td>Total number of devices that are connected to the DMC and thus can be updated through the DMC. It should never be made zero (at least DMC device must be supported).</td>
</tr>
</tbody>
</table>

Fill the rows below for each device type identified for the new design

<table>
<thead>
<tr>
<th>Device Type</th>
<th>dev_type</th>
<th>Type of device that needs to communicate with the DMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component ID</td>
<td>comp_id</td>
<td>Assign incremental (unique) index to the device, which is used by the DMC firmware to uniquely identify the device. Ensure that the DMC is the first component and its index is 0.</td>
</tr>
<tr>
<td>Device Image Mode</td>
<td>img_mode</td>
<td>Image mode of the device</td>
</tr>
<tr>
<td>Row Size indicator</td>
<td>row_size</td>
<td>Flash/ EEPROM row size supported for the device</td>
</tr>
</tbody>
</table>
### Composite Dock Topology Table (CDTT) Entry

<table>
<thead>
<tr>
<th>Entry Field in Dock Config XML</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;dock_info&gt;</td>
<td>Entry field in Dock Config XML</td>
</tr>
</tbody>
</table>

**Device Access Type**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>access_type</td>
<td>Interface protocol (I²C/ SPI/ UART) connecting the device and DMC</td>
</tr>
</tbody>
</table>

**Device Access Port**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>access_port</td>
<td>SCB port number of the DMC that connects to the device</td>
</tr>
</tbody>
</table>

**Access parameters**

See Table 4-6 and Table 4-7

Device-specific access parameters such as the slave address and GPIO (defined in Table 4-6 and Table 4-7 for CCGx and HUB I²C access respectively)

<table>
<thead>
<tr>
<th>Composite Dock Topology Table (CDTT) Entry</th>
<th>Entry Field in Dock Config XML</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>slave address</td>
<td>Address</td>
<td>I²C slave address</td>
</tr>
<tr>
<td>HPI intr gpio</td>
<td>hpi_intr_gpio</td>
<td>GPIO number to be used as the interrupt GPIO for CCGx access</td>
</tr>
</tbody>
</table>

**Table 4-6. CCGx (HPI) I²C Access Parameters**

<table>
<thead>
<tr>
<th>Composite Dock Topology Table (CDTT) Entry</th>
<th>Entry Field in Dock Config XML</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reset gpio</td>
<td>reset_gpio</td>
<td>GPIO number to be used as the reset GPIO input in the case of HX3 access</td>
</tr>
<tr>
<td>WP gpio</td>
<td>wp_gpio</td>
<td>GPIO number to be used as Write Protect GPIO in the case of HX3 access</td>
</tr>
</tbody>
</table>

**Table 4-7. HUB I²C Access Parameters**

4.9.2 Configuring DMC for New Designs

EZ-PD Dock DMC Configuration Generation Tool can be used to recreate DMC images (.cyacd files) with the modified configuration. The tool takes the DMC firmware image in the .cyacd format along with configuration space parameters, as defined in Section 3.9.1, in XML format. For any new dock design, use the following checklist to get the right configuration in DMC images.

1. Get the answers to all questions in Section 3.9.1. Populate the answers in the Dock Config XML file.

2. Create DMC images with the modified configuration using DMC Configuration Generation Tool as described in Sections 4.3 and section 3.6.1. Use DMC images provided with the CCG4 Dock reference design package at <Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/DMC to generate DMC images with the modified configuration.

**Note 1:** Both DMC images provided at <Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/DMC must be regenerated with the modified configuration or re-compile the project with the newly generated configuration table and then use the firmware files. You should make a copy of the firmware files provided in the reference design and make changes only to the copy.

**Note 2:** You cannot change the firmware version of the DMC image using the EZ-PD Dock DMC Configuration Generation Tool.

4.9.3 Configuring CCG4 for New Designs

The CCG4 configuration can be modified based on the application using the EZ-PD Configuration Utility, which is installed along with this reference design. The EZ-PD Configuration Utility is a GUI-based Microsoft Windows application developed by Cypress to guide a CCGx device user through the process of configuring and programming CCGx controllers. The utility allows users to do the following:

- Select and configure parameters.
- Program the resulting configuration to the target CCGx device.
To modify the configuration of CCG4 from what is being used in this reference design, do the following:

1. Read the configuration from the CCG4 firmware image files using the option File > Read from Firmware File. The CCG4 Firmware image files are in <Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/CCG4.
   
   **Note:** Both CCG4 images in <Install Dir>/ EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/CCG4> contain identical configuration parameters. Therefore, either of the two images can be used to read the configuration.

2. Edit the required parameters based on the application requirements. See the EZ-PD Configuration Utility User Manual for details on the various parameters (choose Help > User Manual).
   
   **Note:** You can also create a new configuration using the File > New menu option in the utility. Once all parameters have been updated, you can save the configuration. All modifications are saved to a XML file for future use. The saved file can be loaded later using the File > Open utility menu option.

3. The configuration created or opened in the EZ-PD Configuration Utility can be saved to a pre-existing CCG4 firmware file using the File > Save to Firmware File menu option.
   
   **Note 1:** The CCG4 Firmware image files are located in <Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/CCG4. You should make a copy of the firmware files provided in the reference design and make changes only to the copy.
   
   **Note 2:** Both CCG4 images, corresponding to the CCG4 image 0 and CCG4 image 1, provided in <Install Dir> EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/CCG4 must be regenerated with the modified configuration and used for the new design.
   
   **Note 3:** If the CCG4 firmware image files have their read-only attribute enabled, make them writeable before moving to Step 3.
   
   **Note 4:** You cannot change the firmware version of the CCG4 image using EZ-PD Configuration Utility.

### 4.9.4 Configuring HX3 for New Designs

The HX3 configuration (settings) can be modified based on the application using the HX3 Blaster Plus Utility, which is installed along with this reference design. HX3 Blaster Plus is a GUI-based utility to configure the HX3 hub controller. It can be used to configure any HX3-based hardware with a compatible EEPROM connected to HX3 over I²C.

To modify the configuration of HX3 from what being used in this reference design, do the following:

1. Open the configuration of the HX3 device using the Blaster Plus utility using the option File > Load Settings....
   
   **Note:** The HX3 Firmware image files are located in <Install Dir>/EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/0x_HX3_Tierx. Here, “x” can take the values “1” or “2” in this reference design, depending on the HX3 tier level used in this reference design.

2. Once the settings have been loaded in the GUI, edit the required parameters based on the application requirements. See the HX3 Blaster Utility User Manual (Help > User Manual) for more details on the various parameters.

3. The configuration created or opened in the HX3 Blaster Utility can be saved to the firmware file using the File > Generate HX3 Firmware + Settings File menu option.
   
   **Note:** Both HX3 images provided in <Install Dir>/ EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/0x_HX3_Tier1 and <Install Dir>/ EZ-PD CCGx Dock SDK/Firmware/binaries/CCG4_Dock/0x_HX3_Tier2 must be regenerated with the modified configuration if the new design contains HX3 on more than 1 tier. Firmware for Tier 1 HX3 in the new design must be regenerated using the image in <Install Dir>/EZ-PD CCGx Dock SDK/CCG4 Dock/Firmware/HX3_Tier1. Firmware for any HX3 in tiers greater than Tier 1 in the new design must be regenerated using the image in <Install Dir>/EZ-PD CCGx Dock SDK/CCG4 Dock/Firmware/HX3_Tier2.

### 4.9.5 Create Composite Dock Image for New Designs

After the DMC, CCG4, and HX3 images have been regenerated with the correct configuration based on the application, follow the steps in Sections 4.9.1 through 4.9.4.

1. Follow the instructions in Section 4.6.1 to create the composite dock image.
2. Follow the instructions in Section 4.6.2 to update the devices with the new images.
## 5. Dock Design Checklist

### 5.1 Checklist

Refer to the EZ-PD CCG4 USB Type-C Dock board schematics in `<Install Dir>/EZ-PD CCGx Dock SDK\Hardware\CCG4_Dock`. Refer DMC datasheet for more details.

<table>
<thead>
<tr>
<th>Item#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P3.3 is used as the DMC pin used as the MASTER_RESET for controlling the power to the entire EZ-PD CCG4 USB Type-C Dock. This pin is used by DMC to reset all dock components after firmware update is completed. This ensures that all dock components run the newly updated firmware. For any clarifications on this, contact Cypress.</td>
</tr>
<tr>
<td>2</td>
<td>The HX3 EEPROM used is larger than or equal to 32 KB in size so that two copies of the HX3 firmware images can be placed in the EEPROM. The EEPROM supports at least a 400-kHz operating frequency.</td>
</tr>
<tr>
<td>3</td>
<td>Any unused DMC GPIOs can be used as WP or HX3 Reset (Table 4-3). The DMC pin selected must be updated in the DMC configuration using the EZ-PD Dock DMC Configuration Generation Tool.</td>
</tr>
<tr>
<td>4</td>
<td>Any unused DMC GPIOs can be used as HPI interrupt pin (Table 4-2). The DMC pin selected must be updated in the DMC configuration using the EZ-PD Dock DMC Configuration Generation Tool.</td>
</tr>
<tr>
<td>5</td>
<td>One of the four unused SCB ports of the DMC can be selected for a device to communicate with the DMC. The SCB port number selected must be updated in the DMC configuration using the EZ-PD Dock DMC Configuration Generation Tool.</td>
</tr>
<tr>
<td>6</td>
<td>Ensure that all the hubs, under which the DMC is connected, has a valid firmware image (Image-0) so that DMC with an empty CDTT can enumerate.</td>
</tr>
</tbody>
</table>
6. Troubleshooting Guide

6.1 Troubleshooting EZ-PD Dock Configuration Generation Tool

Note: If any failure occurs, rerun the update using the verbose logging level ("-l v") if the logging level was different. The following sections use error messages captured by running the EZ-PD Dock Configuration Generation Tool with the verbose logging level.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Reason/Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>EZ-PD Dock Configuration Generation tool returns error</td>
<td>DMC image modification fails because DMC images (cyacd) are read-only. Make the files writable by changing the properties and retry the configuration generation step.</td>
</tr>
<tr>
<td>Failed to generate files with default logging level &quot;-l n&quot; And the error message</td>
<td></td>
</tr>
<tr>
<td>System.UnauthorizedAccessException: Access to the path is denied with logging level -l v</td>
<td></td>
</tr>
<tr>
<td>EZ-PD Dock Configuration Generation tool returns error</td>
<td>Ensure that the file name/file paths provided as parameter inputs to the tool are correct.</td>
</tr>
<tr>
<td>Failed to generate files* with default logging level &quot;-l n&quot; And the error message</td>
<td></td>
</tr>
<tr>
<td>System.IO.FileNotFoundException: Could not find file with logging level -l v</td>
<td></td>
</tr>
</tbody>
</table>

Note: Output files generated (.bin and .cfg) will be overwritten every time the tool is invoked.

Contact Cypress for further assistance.

6.2 Troubleshooting EZ-PD Dock Image Creation Tool

Note: If any failure occurs, rerun the update using the verbose logging level ("-l v") if the logging level was different. The following sections use failure messages captured by running the EZ-PD Dock Image Creation Tool with the verbose logging level.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Reason/Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image creation succeeds with message(s): Skipped image#x</td>
<td>This is not a failure. A device image was skipped due to possible reasons as follows:</td>
</tr>
<tr>
<td></td>
<td>• Image path was left empty in the input Dock Config XML file.</td>
</tr>
<tr>
<td></td>
<td>• Invalid images because of checksum mismatch or other reasons</td>
</tr>
<tr>
<td></td>
<td>To update the device image, ensure that a valid device image name/path is provided.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Image creation displays message similar to that below:</td>
<td>The particular device image is found to be not a valid device image due to checksum mismatch. Provide a valid device image name/path in the Dock Config XML file and retry.</td>
</tr>
<tr>
<td>Line checksum mismatch at line yz</td>
<td></td>
</tr>
<tr>
<td>Skipping image#x because image is invalid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Image creation fails with a message Access to the path is denied.</td>
<td>The output file name provided pre-exists which is a read-only file. Provide a new name for the output file or make the file writable. Note: Output files generated (.bin and .cfg) will be overwritten every time the tool is invoked.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Image creation fails with message Could not find file.</td>
<td>The tool could not locate the input Dock Config XML file provided as the input parameter. Ensure that the path and the file name of the Dock Config XML file provided as the input parameter to the tool are correct.</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Behavior</th>
<th>Reason/ Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image creation fails with the message</td>
<td>The XML file used has an incorrect format. Ensure that the Dock Config XML file used has the same template as provided in the CCG4 Dock Reference Design Package.</td>
</tr>
<tr>
<td>System.InvalidOperationException: There is an error in XML document</td>
<td></td>
</tr>
<tr>
<td>Contact Cypress for further assistance.</td>
<td></td>
</tr>
</tbody>
</table>

**6.3 Troubleshooting EZ-PD Dock Firmware Update Tool**

**Note:** If any failure occurs, rerun the update using the verbose logging level ("-l v") if the logging level was different. The following sections use failure messages captured by running the EZ-PD Dock Image Creation Tool with the verbose logging level.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Reason/ Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The DMC device disappears after some time from Device Manager and thus firmware update cannot be attempted</td>
<td>For power saving, the DMC USB interface is disabled approximately after 10 minutes of DMC enumeration. For updating the firmware, disconnect and connect back the dock US port to the PC.</td>
</tr>
<tr>
<td>Firmware update proceeds and shows the status as &quot;Failed&quot; after the firmware update process completes.</td>
<td>Query the dock status using the &quot;-v&quot; parameter of EZ-PD Dock Firmware Update Tool to determine the dock status, which may indicate the possible reason for failure. Reattempt the update if needed.</td>
</tr>
<tr>
<td>The EZ-PD Dock Firmware Update Tool became unresponsive during the update process due to system events, thus making dock components' status uncertain.</td>
<td>Retry the firmware update with the same composite dock image file. Any device image, if corrupted during the previous update, will be updated appropriately.</td>
</tr>
<tr>
<td>Firmware update is seen to fail as soon as it starts with no specific error logs as below:</td>
<td>Ensure that the value used for the dig_sig_algo field in the Dock Config XML was zero while creating composite dock image.</td>
</tr>
<tr>
<td>Loading composite dock image Signature is present in the composite dock image</td>
<td></td>
</tr>
<tr>
<td>The composite dock image is not compatible for the device</td>
<td></td>
</tr>
<tr>
<td>Loading composite dock image failed Connection to DMC closed.</td>
<td></td>
</tr>
<tr>
<td>Exiting the application”</td>
<td></td>
</tr>
<tr>
<td>Firmware update fails with a message from the DMC</td>
<td>The DMC running firmware has the firmware version check enabled, implying that it allows firmware updates to happen only with firmware version having incremental composite version. 1. Query the dock status using the &quot;-v&quot; parameter of EZ-PD Dock Firmware Update Tool to determine the current running composite version of the dock. 2. Update the Dock Config XML to increment the composite_fW_version to a value 1 greater than the value returned in step1 above. 3. Create composite dock image with updated dock config XML. 4. Retry firmware update using the updated composite dock image.</td>
</tr>
<tr>
<td>DMC responded with FW cfg table analysis status: invalid composite version</td>
<td></td>
</tr>
<tr>
<td>Firmware update fails with a message from the DMC:</td>
<td>FWCT (firmware config table) information in the dock composite image is found to be corrupted. Recreate the composite dock image using the EZ-PD Dock Image Creation tool and use the bin file, generated by the EZ-PD Dock Image Creation tool without modification, as input to the EZ-PD Dock Firmware Update tool. Retry firmware update using the new composite dock image.</td>
</tr>
<tr>
<td>DMC responded with FW cfg table analysis status: invalid FW cfg table.</td>
<td></td>
</tr>
<tr>
<td>Behavior</td>
<td>Reason/ Resolution</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Firmware update fails with a message from the DMC:</td>
<td>One of the following dock identification parameters in the Dock Config XML is found to be not matching with the corresponding values in the DMC config space:</td>
</tr>
<tr>
<td>DMC responded with Fw cfg table analysis status: invalid dock identity.</td>
<td>- vid in XML does not match with the dock Vendor ID in the DMC config space.</td>
</tr>
<tr>
<td></td>
<td>- pid in XML does not match with the dock Product ID in the DMC config space.</td>
</tr>
<tr>
<td></td>
<td>- did in XML does not match with the dock Device ID in the DMC config space.</td>
</tr>
<tr>
<td></td>
<td>- cdtt_version in XML is lesser than the cdtt_version in the DMC config space.</td>
</tr>
<tr>
<td></td>
<td>To fix these, create the composite dock image with updated dock identification parameters.</td>
</tr>
<tr>
<td></td>
<td>1. Query the dock status using the &quot;-v&quot; parameter of the EZ-PD Dock Firmware Update Tool to determine above mentioned the dock identification parameters in the current running DMC image.</td>
</tr>
<tr>
<td></td>
<td>2. Identify the parameter mismatch which is causing the failure.</td>
</tr>
<tr>
<td></td>
<td>3. Update the Dock Config XML file to update the appropriate dock identification parameter, identified in the previous step.</td>
</tr>
<tr>
<td></td>
<td>5. Retry firmware update using the updated composite dock image.</td>
</tr>
</tbody>
</table>

| Image-0 status of HX3 is shown as “Recovery”                              | HX3 image-0 and image-1 update failed due to some reason. As a recovery path, DMC writes few configuration bytes to enable the enumeration path for the DMC to in turn enable further updates. Retry the firmware update with valid HX3 images. |
|                                                                          | **Note:** HX3 EEPROM must be at least 32 KB for it to retain two copies of HX3 images. If not, failure to update one image causes HX3 to fall to recovery mode. |

<table>
<thead>
<tr>
<th>Image-0 status of HX3 is shown as “Recovery” even after firmware update retries</th>
<th>HX3 image-0 and image-1 update failed due to some reason consistently.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Check the hardware on the I2C bus connecting the DMC and HX3 EEPROM.</td>
</tr>
<tr>
<td></td>
<td>- Check the sanity of HX3 images. Ensure they are valid HX3 images, built for 400-kHz configuration.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image-0 status of HX3 is shown as “Valid (Recovered from Image-1)”</th>
<th>HX3 image-0 update failed due to some reason. As a recovery path, image 1 was copied to image-0 by DMC. Retry the firmware update with valid HX3 image-0.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> HX3 EEPROM must be at least 32 KB for it to retain two copies of HX3 images. If not, failure to update one image causes HX3 to fall to recovery mode. The DMC code will not be able to recover mage-0 from the fail-safe image (image-1).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Firmware update is seen to fail consistently to any particular device in the dock.</th>
<th>Potential reasons for the failure are listed below:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Ensure the device ordering and comp_id is retained same across the Dock Config XML file and the actual DMC Configuration space. Any change in device ordering is seen as dock topology change and must be accompanied with an incremental cdtt_version in the Dock Config XML file while creating the composite dock image.</td>
</tr>
<tr>
<td></td>
<td>2. Ensure the DMC running image contains the configuration with dock topology corresponding to the board design.</td>
</tr>
<tr>
<td></td>
<td>3. Ensure the dock topology parameters (especially the access parameters) in the Dock Config XML file matches with the board design.</td>
</tr>
<tr>
<td></td>
<td>4. Ensure the images provided for the corresponding device are valid device images.</td>
</tr>
<tr>
<td>Behavior</td>
<td>Reason/ Resolution</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Firmware update is seen to fail with tool failing to acquire the device handle during the DMC re-enumeration. The failure will be seen following the messages: Trying to read interrupt endpoint or Waiting for re-connecting DMC.</td>
<td>One possible reason for the failure can be that the DMC takes more time for re-enumeration than what the tool waits. The default timeout value configured in the tool for DMC re-enumeration is 1 minute (60 seconds). Retry the firmware update with an increased timeout (using &quot;-t&quot; parameter of the EZ-PD Dock Firmware Update tool. <strong>Note:</strong> The approximate time for an average DMC re-enumeration during the failure can be measured by observing the time taken for a device disconnect and connect back in Device Manager.</td>
</tr>
</tbody>
</table>

Contact [Cypress](https://www.cypress.com) for further assistance.
# Revision History

**Document Title:** EZ-PD™ CCG4 USB Type-C Dock Reference Design Guide  
**Document Number:** 002-20322

<table>
<thead>
<tr>
<th>Revision</th>
<th>Issue Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>**</td>
<td>07/20/2017</td>
<td>Initial version of reference design guide</td>
</tr>
</tbody>
</table>
| *A       | 09/27/2017 | Corrected typos  
Updated Figure 4-13 and Figure 4-25  
Added chapter on Installation  
Added section on “Firmware Update with version check” and “Configuring DMC/ CCG4/ HX3 for new dock designs” |
| *B       | 12/13/2017 | Added HPI in Abbreviations.  
Added note on DMC enumeration in Section 4.2  
Updated Table 4-1  
Updated Sections 4.6.1  
Updated Section 4.7.2 heading  
Updated Section 4.8  
Added Section 4.8.3 |
| *C       | 03/29/2018 | Included firmware source and extra documentation  
Changed install directory path  
Updated template |
| *D       | 05/31/2018 | Added a footnote in Table 4-1 and Table 4-4 and also as a Note in section 4.9.1  
Updated the description of bb_vid: and bb_pid |
| *E       | 02/06/2020 | Added new section for hardware revision 04 and revision 05 details.  
Added Revision 05 changes in DMC configuration.  
Changed install directory path  
Updated the command line tool snapshot to reflect the latest one. |
| *F       | 05/05/2020 | Added a footnote in EZ-PD Dock DMC Configuration Generation Tool  
Updated Table 4-1 |
| *G       | 07/14/2020 | Updated web links for Dock SDK 3.3 |